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1. Overview

WebXone is a RIA-oriented (Rich Internet Applications) rapid development platform. It is a new
generation of Web application which combines the best Ul of Desktop application, the popularity and fast,
lost-cost deployment of Web application and, real-time of interactive multimedia communication. It
applies WebXone and can use common desktop application tools such as Delphi/CBuilder/VC to rapidly
develope application system which is suitable for network.

WebXone is based on mature development platforms such as Delph/CBuilder/\VC, and compatible
with all the VCL controls, and use unified system interface. It can quickly build a Web application system
which can run efficiently.

WebXone enables Web development fast and efficient and enables web applications to run fast!

1.1 Objectives

It enables users to apply Delph/CBuilder/VC to achieve B/S programming easily.

1.2 Features

Apply programming tools such as Delph/CBuilder/VC to develop web applications directly.
Compatible with all the VCL controls of Delph/CBuilder;

Support transform from C/S programs to B/S programs;

High running efficiency which rivals C/S programs;

Easy and quick Web deploying method,;

Compatible with all the mainstream browsers including IE(IE6~IE11), Chrome, FireFox, Safari,
Opera, efc

2. Instructions

2.1 Deploy environment of the Web server

(1) Download SDK.

SDK download: http://www.cocodex.com/download-free/webxone.zip
(2) Decompression and copy

Decompress webxone.zip, and enter WWW directory, as shown below.
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Run web server program “WebServ.exe” in WWW directory, as shown below.

ro WebXone Server E@ﬂ‘
Start l Stop ] [ Clear ] [ Hide ] Port 2020 Clients: Webxorle

new web solutions

2.2 Create a WebXone application with Delphi.

Take Delphi7 as an example

)

New a common Delphi application

New an application, then put Labell in forml, and set the “Caption” as “Hello,WebXone!”. Then

save the project as “hello.dpr” and the file directory is C:\hello
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(2) Convert to WebXone application

Copy “wxoExec.pas” and “wxoBase.dll” in the “demos\public” directory of WebXone SDK to
C:\hello\, as shown below.
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Organize » Include in library « Share with + Mew folder * [ @
- . ||
< Favorites MName Date modified Type
Bl Desktop || hello.cfg 6/23/201511:43 PM  CFG File
& Downloads | hello.dof 6/23/201511:43 PM  DOF File
5l Recent Places Ef,D hello 6/23/201511:43 PM  Delphi Project
:_b’ hello 6/23/201511:44 PM  Application
ﬁ Libraries | hello.res 6,/23/201511:42 PM  RES File
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(=] Pictures 5? Unitl 6/23/201511:44 PM  Delphi Source A
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Add references to wxoExec in unitl.pas, as shown below.



=] UnitLpas - E@
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1 unit Unitl: -

2 ol

3 interface

4

5 uses

13 wxoExec,

7 Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,

8 Dialogs, StdCtrls:

E type E
10 TForml = class (TForm)

11 Labell: TLabel;

1z procedure FormCreate (Sender: TObject):

13 private

14 { Private declarstions }

15 public

18 { Public declarations } B
17 end;

18 var

1s Forml: TForml:

20

z1 implementation

22 {SR #*._.dfm}

23

24 procedure TForml.FormCreate (Sender: TCbject);

25 begin

28 wxoPrepare (Handle,Application.Handle);

27 end;

28 B
l 29 end.

30 -
= | v
23 1 Madiied Insert ' Code/{Diagram
T

Then add wxoPrepare in the OnCreate procedure such as
procedure TForml.FormCreate(Sender: TObject);
begin

wxoPrepare(Handle,Application.Handle);
end;
Then compile to EXE.
(3) Deploy to server
Run WXOConfig.exe in “WWW” directory in WebXone SDK
Choose output directory as C:\WWW,
Open C:\hello\hello.exe, as shown in the picture

System  Edit Help

o8 0 X 4 & g @@ |

Open Save Generate Remove Select all Batch Threads  Add Order Now | Help
Output Dir |C:\Users\Billows\Desk‘top\webxcne\webxcne\W\ [G_Q”Test " Trial Version |
D File Name | Size(b) | DateTime ‘ Load Mude| Directory
0 | hello.exe 369,664 2015-06-23 23:44:13

1 |hello.cfg 684 2015-06-24 08:08:26 Automatic

2 |hello.dof 3,574 2015-06-24 08:08:26 Automatic

3 |hello.dpr 185 2015-06-23 23:43:14 Automatic

4 |hello.res 876 2015-06-23 23:42:18 Automatic

5 |Unit1.dcu 3,738 2015-06-23 23:44:13 Automatic

6 |Unitl.dfm 661 2015-06-23 23:44:00 Automatic

7 |Unitl.pas 495 2015-06-24 07:57:32 Automatic

& |wxoBase.dll 391,680 2014-12-29 22:57:06 Automatic

9 |wxoExec.dcu 9,414 2015-06-23 23:44:13 Automatic

10 | wxoExec.pas 13,044 2015-06-09 23:08:54 Automatic

Selection menu: Edit->SelectAll, then: Edit->Remove, as shown in the picture



System Edit Help

DB 0 X & & ==,

| g o |

Open Save Generate Remove Select All Batch Threads Add Order Now | Help

Output Dir |C:\Users\Billcws\Desk‘top\webxone\webxone\W\. Go lTest" Trial Version ‘
D File Name | Size(b) ‘ DateTime | Load Mude| Directory

0 |hello.exe 369,664 2015-06-23 23:44:13

Then the menu is generated, a dialog box pops up, as shown below.

r b

Register

Thank you for using our product. Pleaze purchase a license
for life-time use! After registered | this reminded section will
disappear.

Waitng .. 4

h

This is the dialog box for registration, and ignore it, wait for 5 seconds and click Continue. Now the

deployment is finished.

2.3 Web access

Open IE, and input the following in the address bar
http://localhost:8080/index.htm?hello

Note : the portis 8080

Now the installation interface of WebXone plug-in is supposed to appear.

Click “Download” download setup.exe and run it.
Click “Run”


http://localhost:8080/index.htm?hello

| ﬁ Setup - WebXone plug-if_ lll:‘.h

Welcome to the WebXone plug-in
Setup Wizard

This will install WebXone wersion 2.5.2 156021 on
your computer.

It is recommended that you close all other
applications before continuing.

Click Next to continue, or Cancel to exit Setup.

| Hext > ][ Cancel ]

Click "Next”

Completing the WebXone plug-in |
Setup Wizard

Setup has finished installing WebXone plug—in on
your computer. The application may be launched by "
selecting the installed icons.

Click Finish to exit Setup.

Installation is finished, click“Finish”, and refresh the page.

Now the program “Hello,WebXone!” written just now can be seen, as shown below




& Forml - Windows Internet Explore

S e €] http://localhost:8080/index.htm?hello

[ i Favorites | g [ Suggested Sites v [&| Web Slice Gallery +

| @ Formt f5 v B ~ [ & ~ Page~ Safety~ Tooks~ @~

l Hello, WebXone!

Done & Internet | Protected Mode: Off Fa v H100% -~

2.4 Apply C++ Builder to develop WebXone application

Take C++ Builder6 as an example to introduce the development process

1. Run C++ Builder6 , menu File > New - Application, create an application and add a
Label control. Set the captionas“Hello,World!”. Save the file as unit1.cpp, the name of the
project is cb.dpr;

2. Copy wxoExec.cpp and wxoBase.dll in the public directory of WebXone SDK to the
directory which cb.dpr is in.

3. Menu :Project - Add to project, choose wxoExec.cpp;

Add references#include “wxoExec.cpp” in unit1.cpp

4, Add codes in the OnCreate event

wxoPrepare((unsigned int)Handle,(unsigned int)Application->Handle);
As shown in the picture

_ Fastcall TForml::TForml (TComponent® Cwner)
: TForm(Cwner)
{
wxoPrepare | (unsigned int)Handle, (unsigned int)Application->Handle):;

4 1 Insert " Urit1.cpp /A Urit].h /A Diagram /

.

The compile to exe. (flash across by F9 is normal)

5. For further package deployment, please refer to relevant partin  2.2.



3. Support of the relevant system

3.1 the support of browsers

Support all browsers such as IE, Chrome, FireFox, Safari, Opera, etc.

3.2 the support of the client-side operating system

The client support Window 2000/Win 2003/ Win Xp/Win7 32\Win7 64/\Win8
Now the client does not support OS X. Linux and Android.
note: Win7/MWin8 non-administrator users should close UAC.

3.3 support of development tools

Support Delphi (Delphi 5 ~ XE8)
Support C++Builder (CB 6 ~ XE8)
Support Visual C++

Delphi are recommended.

3.4 support of the server operating system

Server operating system supports all the operating systems including Windows, Linux, iOS.

3.5 support of the server service programs

The server support all the service programs including 11S, Apache and othe. The customized WebServ in
the above document can be replaced.

3.6 Support of the database.

Support all the database systems.

3.7 Support of the middleware

Support alll the middlewares including RTC, RO.



4. Frequently asked questions

Can registered user have access to further update?
Answer: it's a lifetime license.

® Is mobile platform enabled on client-side?
Answer: no
® Does the further update have a product support mobile platform?

Answer: We are developing a new product name DeoWeb. The specific content and time is to be
determined.

[ Can it be deployed in Linux server?
Answer: Yes! WebXone site can be deployed in Linux server.
® Does it support hundreds of people or more online together?

Answer: Yes! Someone has developed a system supporting tens of thousands of clients based on
WebXone.

° Why does load fail and there is 126 error?

Answer: Because some attached file are used in the application (such as DLL), but it does not exsit on
the client-sid and requires to add this file when users package using WXOConfig.

® How to package many files by WXOConfig (including some configuration files and dynamic

link library) ?

Answer: Copy WebXone application as well as other relevant files (such as configuration files,dll,etc) to a
void directory and open the application(wox or exe) by WXOConfig, and generate it directly.

Note: Output directory is supposed to be web directory
® How to pass parameters by URL?

Answer: You can pass parameters by URL string.
Just an example



WWW.XXXXXXX.com/index.htm?id=ggg&&abcde.

The website will open the “ggg” application. The program can get URL string by _wxoGetUrl and parse it
in the program.

Note:

1. “id="is necessary!

2. Separator is “&&”

® |f the application is large, will run-up time be long because client-side has to load the

application every time?

Answer: The Intelligent compression loading mechanism WebXone applies load compressed programs
and compresses it automatically when client-side have access to it for the first time. Afterwards if
client-side has access to it, client-side compares the local files with server-side files automatically. If
server-side files are not updated, there is no second upload.

® Can WebXone have access to local port, and how about operating serial port or printer

Answer: You can operate the local port including serial port, parallel port, USB, printer, etc.

® How to amend page title?

Answer: Through wxoSetTitle. Please see demo: Functions

® How to close the page?

Answer: Through wxoClose. Please see demo: Functions

® Is MDI supported?

Answer: Yes. Please see demo: MDI

® How to shorten URL?

Answer: If the application name is default.wxo or default.exe ,“?” as well as the following application
name are not required to be added after employment and WebXOne web application can be visited
directly, such as http://www.athtek.com/webxone/demos.html. If you want to shorten it further, you can
have access to it through the configuration of IS and Apache like http://www.athtek.com/webxone/demo/.



® [sitsupported to customize directory installation?
Answer: Yes.
® Is it supported to customize relevant information of setup.exe?

Answer: Yes. The ordered users can get source code of setup.exe (inno setup), and can amend

information such as the names of the plug-ins, developers, version number, etc. by yourself.

5. Recent update

2015-06-24 version 2.5.2.0

Support thread count when loading ...;

Add batch mode. it can speed up loading

Add wxoRunJS to run JavaScript in application;
Add wxoGetUrl/wxoShowModal/wxoMessageDlg/...

a b~ W N -

Some bug fixes

2013-11-01 version 2.4.0.0

1 Add the ability to implant EXE directly, and compatible with all the VCL controls completely ( highly
recommended ).

2 Add the ability to support MDI.

3 Add the ability to exit automatically for WXO in exceptions (mainly aim at some browsers for the
minority)

4 Update setup.exe, solve the problem of forgetting to exit the browser when updating.

2013-05-23 version 2.3.6.0

Add the ability to deal with exceptions when exit and compatible with VCL controls better.
Add the ability to run JavaScript.

Add the ability to deal with main window such as OnClose.

Add digital signature.

Solve the problem of 360 reporting virus.

Solve the bug that it is easily blocked when using FireFox.

~N o o b~ WN

Apply “MD5+size of the file+time” for duplication check and it is more stable.



2012-12-18 version 2.3.0.2

Compatible with all the mainstream browsers including IE, Chrome, FireFox, Safari and Opera;

Add the ability to embed automatically of non-main windows.

Cancel the registration restriction and all developers have free access to it and have no restrictions.
Add the lightweight server program WebServ to debug systems fast.

Add the attachment loading mode and add the "load not update" mode on the basis of original model;

S O~ WN P

Redesign wxoUnit, and make it more convenient and quick for transition from ordinary procedure to
WebXone.
7 Apply MD5 to update verification and it is more scientific than the original size+time.

2012-06-20 version 2.2

1. Apply modular construction, and the system can be updated gradually.
2. Amend the loading directory to solve the requests of Oracle have for directories.

2012-03-27 version 2.1

1. Have free aceess to single WXO mode.

2. Have free access to applications which have less than 5 attached files.

3. Amend the registration mode and users can release applications for infinite times and development
and deployment don not bind to computers.

4. Support customized installation interface (index.html source codes are supported)

2012-03-19 version 2.0

1. Add multi-annexfile deployment.

2. Add the ability to compressing load and increase the loading speed greatly.

3. Apply the intelligent loading technique and decreatse the loading time for the second load to almost O;
4. Test the third party control (such as cxGrid) further.

2011-12-10 Version 1.1

1. Add the demo such as Hello,World!

2. Solve the bug that directory can be generated.
3. Solve some unsuccessful LoadLibray bugs.

2011-11-21 Version 1.0
Achieve WebXone 1.0, and users can apply tools like Delphi generate web applications.



6. Protocol

An application including many files at one time can be released.

Support multi file intelligent compress deployment

Deploy package operation(WXOConfig.exe) can run in many computers;
Have free access to the Delphi source code and controls of WebServ.exe;
Have free access to innosetup-format source code of setup.exe;

Have free access to one set of CRM source code;



An:

1. Win7 non-admin users close UAC

Input the following directly in operation:
“C:\Windows\System32\UserAccountControlSettings.exe”. The settings for UAC pops up directly and
then choose “Never Notify”. Some users are supposed to restart the computers.

2. Introduction of WebXone deploy tool: WXOConfig

WXOConfig is a tool to package and deploy WebXone application (processed .exe files) and it's
attached files.
Basic operations:
(1) Preparations: New a directory and copy all application files into the new directory;
(2) * Execute WXOConfig.exe;

wxoConfig ¥2.5.2.0 --- WebXone Web Deploy (2015-06-22) -

System Edit Help

=8 0 X @ & ¢ @ @

Open Save Generate Remove Select All Batch Threads Add Order Mow | Help

Output Dir diwww2520% Trial Version

ID File Name | Size(b) | DateTime | Load Mode | Directory

(3) Choose the “Output Dir” you plan to output to including the directory “index.htm”,
“WebServ.exe” and “setup.exe”;

(4) * Choose the WebXone processed .exe file;

(5) Manage attached files: Menu “Edit’--->"Delete” to delete the chosen attached files;

(6) Configure attached files’ mode: Menu “Edit’--->"Set current file Load ....” To configure the
current attached files;

(7) Choose load thread count: single ~ 5 threads;



(8) Choose package mode : batch or not;
(9) * Package and deploy: Menu”Generate” to finish.

* Required!



